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Preface

This guide is part of the EMC® Legato NetWorker® documentation set. For a complete 
list of documents related to the use of this product, see "Related Documentation" on 
page 8.

For the most up-to-date information on the features of NetWorker™, refer to the 
Release Notes.

Audience
The information in this guide is intended for system administrators who are 
responsible for installing software and maintaining the servers and clients on a 
network. Operators who monitor the daily backups may also find this manual useful.

Organization
This guide is organized as follows: 

• "Chapter 1: Introduction" on page 10 provides an overview of the NetWorker 
product.

• "Chapter 2: Updating from a Previous NetWorker Release" on page 13 explains 
how to update from a previous release of NetWorker software.

• "Chapter 3: Installing NetWorker Software on AIX" on page 17 explains how to 
install NetWorker software.

• "Chapter 4: Installing NetWorker Software in an HACMP for AIX Environment" 
on page 31 explains how to install NetWorker software in a High Availability 
Cluster Multiprocessing for AIX (HACMP for AIX) environment. 

• "Chapter 5: Installing NetWorker Software in an EMC FullTime AutoStart 
Environment" on page 45 explains how to install NetWorker software in an EMC 
Automated Availability Manager environment.

• "Chapter 6: Evaluating and Licensing NetWorker Software" on page 58 explains 
how to enable the NetWorker software and features for permanent use. It also 
describes the NetWorker licensing model and provides a basic explanation of 
licensing for the different NetWorker Editions, modules, and features.



EMC Legato NetWorker, Release 7.3, AIX Version
Installation Guide

Preface

8

Related Documentation
The following NetWorker documentation is available for download:

• NetWorker Release 7.3, Multiplatform Version, Administration Guide

• NetWorker Release 7.3, UNIX Version, Release Notes

• NetWorker Release 7.3, Multiplatform Version, Disaster Recovery Guide

• NetWorker Release 7.3, Command Reference Guide

• UNIX man pages
• Legato Software Compatibility Guide

All NetWorker manuals are provided in PDF format on a separate Documentation 
Suite CD as part of the product media kit. If you do not have access to this CD, you can 
view and download NetWorker documentation PDF files directly from 
www.Legato.com.

Conventions Used in This Guide
This document uses the following typographic conventions and symbols to make 
information easier to access and understand.

Convention Indicates Example

boldface Names of line commands, 
daemons, options, programs, or 
scripts

The nsradmin command starts the command 
line version of the NetWorker Administrator 
program.

italic in text Pathnames, filenames, computer 
names, new terms defined in the 
Glossary or within the chapter, or 
emphasized words

The specifications are created, one for each 
swap file, in c:\pagefile.sys.

italic in command 
line

A variable that must be provided 
in the command line

save -s server_name

fixed-width Examples and information 
displayed on the screen

media waiting: recover waiting for 
8mm 5GB tape volume name

fixed-width, 
boldface

Commands and options that 
must be entered exactly as shown

nsr_shutdown -a

Menu_Name>
Command

A path or an order to follow for 
making selections in the user 
interface

Volume>Change Mode>Appendable

Important: Information that must be read 
and followed to ensure successful 
backup and recovery of data

Backslash (\) Paths for both Windows and 
UNIX unless specified otherwise

<NetWorker_install_path>\logs

Important: Use the no_verify option with 
extreme caution.

http://www.legato.com
http://www.legato.com
http://www.legato.com
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Where to Get Help
Company, product, and technical information can be obtained as follows. 

Technical Support

For customers and partners with an active support agreement, go to 
http://softwaresupport.emc.com for information about software patches, technical 
documentation, and support programs. 

For customers without an active support agreement, please contact Support Sales and 
Renewals for more information. 

Support Sales, Renewals, and Licensing

For additional information about EMC storage products and services, go to:

http://www.Legato.com/support/contact/index.htm

To license and register this product, go to:

http://www.Legato.com/support/licensing

Your Comments
Comments and suggestions about our product documentation are always welcome. 

To provide feedback:

1. Go to http://softwaresupport.emc.com.

2. Navigate to the Product Documentation page. 

• To comment on a particular guide, click the Comments link next to the 
guide’s title. 

• To tell us how you prefer to use documentation, click Document Survey. 
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Chapter 1: Introduction

This chapter provides background information on NetWorker software and supported 
devices. It includes the following sections:

• "About the EMC Legato NetWorker Product" on page 10
• "Supported Devices" on page 12
• "Enabler Codes" on page 12

About the EMC Legato NetWorker Product
The NetWorker product is a suite of storage management software that provides 
backup, recovery, and other services to computers with a wide variety of operating 
systems and data types. NetWorker products for different operating systems are 
interoperable. This provides the flexibility to design a storage management system that 
works best with any computing environment.

The NetWorker software is distributed in the following formats:

• In a media kit of CD-ROMs that contains the software and electronic 
documentation for several related EMC products.

• As a downloadable archive file from the Legato website.

The NetWorker product has four major components: 

• NetWorker client
• NetWorker storage node
• NetWorker server
• Legato License Manager



EMC Legato NetWorker, Release 7.3, AIX Version
Installation Guide

Chapter 1: Introduction

11

NetWorker Client

The NetWorker client software communicates with the NetWorker server and provides 
recover and ad hoc (manual) backup functionality. The NetWorker client software is 
installed on all computers that are backed up to the NetWorker server. 

NetWorker clients do not have to be the same operating system as the NetWorker 
server. However, to back up clients with other operating systems, the NetWorker 
server must have a ClientPak® enabler for that client. 

For example, in order for the NetWorker server for AIX to back up NetWorker clients 
of another operating system, a separate ClientPak enabler must be purchased and 
entered for that client operating system.

NetWorker Storage Node

Data can be backed up directly to devices attached to a NetWorker server or to a 
NetWorker storage node. A storage node controls storage devices such as tape drives, 
autochangers, and silos.

Storage nodes depend on the NetWorker server for the following functions:

• Control over which clients use the storage node’s devices for backups.
• License management.
• Index management of the media database that tracks the data contained on each 

volume.

NetWorker storage nodes and the NetWorker server can use different operating 
systems. To use a NetWorker storage node on an AIX operating system with a 
NetWorker server on another operating system, the storage node’s enabler on the 
server must be of the same edition as the base enabler for the NetWorker server. 

NetWorker Server

The NetWorker server software provides control and scheduling for NetWorker 
operations. 

The following tasks can be performed on the NetWorker server:

• Enter the enabler licenses for the NetWorker server and all the functions it 
controls, such as autochanger modules, additional client connections, and 
ClientPak licenses.

• Define the clients, devices, and media that the NetWorker server controls.
• Define the schedules for backups and other operations.
• Monitor the results of backups and other operations.
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NetWorker Console Server

All NetWorker servers and clients are managed from the NetWorker Console server. 
The Console server also provides reporting and monitoring capabilities for all 
NetWorker servers and clients. The Console server must in be installed on a Solaris, 
Windows, or Linux host in order to administer NetWorker servers. 

The Console server is accessed through a graphical interface that can be run from any 
computer that has a web enabled browser. Multiple users can access the Console server 
concurrently from different browser sessions. A computer that hosts the web enabled 
browser can also be a NetWorker client, server, or storage node.

Legato License Manager

The Legato License Manager provides a central place for managing the licenses of all 
the NetWorker clients and servers. Instead of managing licenses separately, all 
NetWorker licenses can be maintained from a single computer. Installation of the 
License Manager is an option when installing the NetWorker software.

For more information about the Legato License Manager, refer to the Legato License 
Manager Installation and Administrator’s Guide and the Legato License Manager Release 
Notes.

Supported Devices
NetWorker software supports a variety of media types and devices, either stand-alone 
or in an autochanger or silo tape library. Devices can be attached to a NetWorker server 
or a designated storage node. To obtain the latest list of supported devices, refer to the 
Legato compatibility guides at www.Legato.com.

A nonrewinding device must be used for NetWorker backups. The pathnames for 
these devices must follow the Berkeley Software Distribution (BSD) semantic rules, for 
example, /dev/rmt/0mbn. The b in the pathname satisfies the semantics requirement. If 
a file type device is used, enter it as a directory path (the same as for other device types) 
rather than as just a filename.

The term autochanger refers to a variety of backup devices: 

• autoloader 
• carousel
• datawheel
• jukebox
• library
• near-line storage

Enabler Codes
Enabler codes (licenses), which activate the functionality of NetWorker software and 
other EMC software, are sold separately. For more information, see 
"Chapter 6: Evaluating and Licensing NetWorker Software" on page 58.
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Chapter 2: Updating from a Previous NetWorker
Release

This chapter explains how to update from a previous release of NetWorker software. It 
includes the following sections:

• "Introduction" on page 13
• "Updating from a Previous NetWorker Release" on page 13

Introduction
When updating to release 7.3 from NetWorker release 6.x or earlier, the client file 
indexes are automatically reorganized into new directory structures.

Important: When updating to NetWorker release 7.2 or later format, there is no way to 
revert to a previous release of the NetWorker software. It is a one-way conversion.

Updating from a Previous NetWorker Release
Use the following roadmap to complete the update process by converting the media 
database and the client file indexes:

• "Task 1: Prepare to Update the NetWorker Software on the NetWorker Server" on 
page 14

• "Task 2: Update the NetWorker Software" on page 15
• "Task 3: Enable and Register the Software" on page 16

Note: The NetWorker index conversion requires enough free disk space to match the 
largest client file index being converted. This space is used during the conversion 
process and will be released when completed. Following conversion, the media 
database should be approximately twice its original size. The client file indexes will be 
20% to 40% smaller. These storage requirement changes are permanent.
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Task 1: Prepare to Update the NetWorker Software on the NetWorker Server

Before updating the NetWorker software, see "Updating from a Previous NetWorker 
Release" on page 13 to ensure that all the necessary requirements have been met.

To prepare to update the NetWorker software:

1. Back up all client file indexes and generate a bootstrap for the server.

If the current bootstrap and client file indexes are not backed up, perform 
scheduled backups on all of the clients before updating to the current NetWorker 
release. 

For example, to save the bootstrap information, enter the following command: 

savegrp -O group

Note: Ensure that all clients are included in the groups being backed up.

2. Record the latest bootstrap save set ID and its associated volume label. To obtain 
this information, enter the following command:

mminfo -B

3. If the NetWorker software is not currently installed in the default location, record 
the location of the client file indexes.

4. Keep a copy of the current configuration. The NetWorker software installation 
script modifies the following files during the installation process:

• /etc/inittab

• /etc/rc.nsr

• /etc/rpc

• /etc/syslog.conf

5. Copy the current configuration as follows:

cp /etc/inittab /etc/inittab.old

cp /etc/rc.nsr /etc/rc.nsr.old

cp /etc/rpc /etc/rpc.old

cp /etc/syslog.conf /etc/syslog.conf.old
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Task 2: Update the NetWorker Software

Note: A NetWorker storage node release 7.3 is not compatible with a NetWorker server 
earlier than release 6.0. Update the NetWorker servers before updating a storage node.

To update the NetWorker software on the NetWorker client, storage node, and server:

1. Keep a copy of the current configuration.

2. Shut down the NetWorker software:

nsr_shutdown

3. Remove the earlier NetWorker release, but do not remove the /nsr directory:

a. Change to the NetWorker installation directory. For example:
/usr/bin

b. Enter the following command to remove the NetWorker software: 
Release 6.x: nsr_ize -u
Release 7.x: smitty remove

4. Enter the following command to install the new release of the NetWorker software:

smitty install_latest 

5. Apply any required NetWorker software patches.

6. Restart the NetWorker daemons by running the NetWorker startup script:

/etc/rc.nsr start

The media database and the client file index are converted automatically.

The client file index conversion can be enhanced by running multiple instances of the 
nsrck program concurrently. This process converts multiple client file indexes in 
parallel. To convert multiple client file indexes in parallel, use one of the following 
methods:

• Specify the client file index to convert. For example:
nsrck client_name

• Enter the nsrck command without a client name. This initiates the conversion of 
the next client in the list.
Each instance of nsrck occupies a portion of the server’s processing, memory, and 
space-swapping capability. Balance the speed of converting the indexes against 
other NetWorker server needs. Monitor system performance by using a diagnostic 
tool to determine the optimum number of nsrck instances to launch.
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New Resource Database Replaces nsr.res, nsrjb.res, and nsrla.res Files

In NetWorker releases earlier than 7.0, all resource information was stored in *.res files. 
To provide better performance and improved scalability, NetWorker release 7.3 
replaces the following files with a new NetWorker resource database:

/nsr/res/nsr.res 
/nsr/res/nsrjb.res

The configuration information for the /nsr/res/nsr.res and the /nsr/res/nsrjb.res files now 
resides in the following directory structure:

/nsr/res/nsrdb/00
.
.
.

/nsr/res/nsrdb/09

The configuration information for the NetWorker Client Execution daemon (nsrexecd) 
now resides in the following directory structure: 

/nsr/res/nsrla/00
.
.
.

/nsr/res/nsrladb/09

Within this directory structure, each resource is stored in a separate numbered file. As 
new resources are created (such as, Client, Group, or Pool resources), new files are 
added in these directories. 

Task 3: Enable and Register the Software

To enable and register the NetWorker software, see "Chapter 6: Evaluating and 
Licensing NetWorker Software" on page 58.
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Chapter 3: Installing NetWorker Software on AIX

This chapter explains how to install NetWorker software. It includes the following 
sections:

• "Software Installation Roadmap" on page 17
• "Installation Requirements" on page 18
• "Installing the NetWorker Software" on page 21
• "Verifying the Installation" on page 26
• "Uninstalling the NetWorker Software" on page 30

Software Installation Roadmap
Use the following roadmap when installing NetWorker software:

1. Review the installation requirements and note the default directory location and 
the installation file space requirements. See "Installation Requirements" on 
page 18.

2. Install the required NetWorker software. See "Installing the NetWorker Software" 
on page 21. For further installation information, see the following sections: 

• To install the NetWorker software in a noncluster environment, see "Installing 
the NetWorker Software" on page 21.

• To update from a previous release of the NetWorker software, see 
"Chapter 2: Updating from a Previous NetWorker Release" on page 13.

• To install the NetWorker software in a FullTime AutoStart environment, see 
"Chapter 5: Installing NetWorker Software in an EMC FullTime AutoStart 
Environment" on page 45.

• To install the NetWorker software in an HACMP for AIX environment, see 
"Chapter 4: Installing NetWorker Software in an HACMP for AIX 
Environment" on page 31.

3. Verify the installation. See "Verifying the Installation" on page 26.

4. Enable and register all of the NetWorker products. See "Chapter 6: Evaluating and 
Licensing NetWorker Software" on page 58.
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Installation Requirements
The system requirements differ for each of the following installation types:

• "Client Software" on page 18
• "Storage Node Software" on page 19
• "Server Software" on page 19

The NetWorker software must be installed in the order listed above.

Important: Before installing the NetWorker software, ensure that the operating system 
is up to date with the most recent patches. 

Note: The NetWorker software does not support locales (defined by the operating 
system) or code sets that remap characters having special meaning for file systems. 
Depending on the file system, these special characters may include the slash (/), the 
backslash (\), the colon (:), or the period(.). For example, De_DE.646 is an unsupported 
locale. For detailed information, refer to the NetWorker Administration Guide.

Client Software

This section describes NetWorker client installation and system requirements:

• "System Requirements" on page 18
• "Installation Requirements" on page 19

System Requirements

System requirements differ depending on whether or not the clients have the same 
operating system as the NetWorker server. 

To install NetWorker software on clients:

• Running the same operating system as the NetWorker server, use the same 
installation media used to install the NetWorker server.

• Running a different operating system than the NetWorker server, use the 
NetWorker client software for that operating system on each client computer. For 
more information, refer to the appropriate installation guide.

Note: NetWorker release 6.1 and later are not supported on AIX versions earlier than 
version 4.3.
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Installation Requirements

In order for NetWorker clients to use the NetWorker server to back up and recover files, 
they must be able to access the NetWorker software.

A client can access the NetWorker software in one of two ways:

• Clients are installed with NetWorker installation packages directly on their local 
disks.

• Clients are configured with a network file system (NFS) mounted directory on the 
remote system where the NetWorker programs are located.

To back up a NetWorker client, the nsrexecd daemon must be active on the client. To 
avoid errors during a scheduled backup of the client, ensure that the nsrexecd 
command is in each client’s startup file.

Storage Node Software

At least one supported storage device must be attached and installed. The device can 
be a stand-alone device, autochanger, or silo tape library. For a list of supported 
devices, refer to the Legato Hardware Compatibility Guide.

To prepare for installation on the computer designated as the NetWorker storage node:

• Ensure that an enabler code is purchased for the storage node.
• After installing the storage node software, configure the driver software to 

provide support to back up data to the SCSI storage devices attached to the 
system. 

• Ensure that at least 40 MB is available on the computer disk.

Server Software

The following sections describe the NetWorker server installation requirements:

• "Installation Requirements" on page 19
• "System Requirements" on page 20
• "Space Requirements" on page 20

Installation Requirements

On the computer designated as the NetWorker server, install the NetWorker software 
in the following order: 

1. Client 

2. Storage node

3. Server 

Install all of the NetWorker software on the server at the same time.
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System Requirements

To install NetWorker software on an AIX server, ensure that:

• The computer has the necessary disk space. For space requirements, see Table 1 
on page 20. 

• The directory on the server is large enough for the NetWorker resources, client, 
server indexes, and media database (usually /nsr). 

• The system pathname to at least one storage device is known. The storage device 
is used by the NetWorker server to back up and recover files. 
If a tape device is used to back up data, use a valid pathname for that device. For 
example, /dev/rmt0.1. Additionally, ensure that the tape device block size is set to 
variable.
Note: The tape device must be nonrewinding.

• Acrobat Reader has been installed to view PDF files. This requires a directory 
with enough space to install the software that is included with the NetWorker 
distribution files.

Space Requirements

Table 1 on page 20 outlines space requirements on the server.

Table 1. Default Locations and Space Requirements

Software/Documentation Files
NetWorker Server 
Location

Space 
Needed

NetWorker Client program files /usr/bin 33 MB

NetWorker Storage node program files /usr/bin 12 MB

NetWorker Server program files /usr/bin 23 MB

NetWorker device drivers /usr/sbin 41 MB

NetWorker man pages /usr/share/man 1 MB

PDF files optional1 1 MB

Client file index, resources, and media database2 /nsr variable3

Legato License Manager /usr/bin 2 MB
1 You manually copy these files from the installation media to your disk.
2 For information about changing the default installation location of these files, see "Task 2: Install the 
NetWorker Software" on page 22.
3 For help calculating the space needed based on the number of clients and the backup policy, refer to the 
NetWorker Power Edition Performance Tuning Guide.
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Installing the NetWorker Software
The following sections explain how to access and install the NetWorker software:

• "Task 1: Access the NetWorker Software" on page 21
• "Task 2: Install the NetWorker Software" on page 22
• "Task 3: Change the NetWorker Servers with Access to a Client" on page 24
• "Task 4: Start the NetWorker Daemons" on page 25

Task 1: Access the NetWorker Software

The NetWorker software can be accessed from one of the following sources:

• "From a Local CD-ROM Drive" on page 21
• "From the Website" on page 21

Important: The evaluation release of the NetWorker software contains tarred and 
compressed versions of the NetWorker software distribution files. Ensure that there is 
adequate disk space to contain both the compressed download file (about 40 MB) and 
the fully uncompressed files (about 120 MB).

From a Local CD-ROM Drive

To access the NetWorker software from a local CD-ROM drive:

1. Log in as root on the computer where the NetWorker software is being installed.

2. Mount the CD-ROM drive.

3. Locate the appropriate directory on the CD-ROM.

From the Website

To access the NetWorker software from the website:

1. Log in as root on the computer where the NetWorker software is being installed.

2. Complete and submit the Evaluation Download Request page located at 
http://www.Legato.com/resources/downloads

When you have completed and submitted the Evaluation Download Request page, 
you will receive an email with the URL to download the NetWorker software. 

3. Download the NetWorker evaluation software to a temporary directory.

4. Uncompress the downloaded software by using the following command:

gunzip nw_aix.tar.gz 

5. Extract the uncompressed, tarred file by using the following command:

tar -xvpf nw_aix.tar

The NetWorker distribution software directories and files are listed on the screen 
as the extraction proceeds.
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Task 2: Install the NetWorker Software

This task explains how to install the client, storage node, and server software. It 
includes the following sections:

• "Client Installation" on page 22
• "Storage Node Installation" on page 23
• "Server Installation" on page 23

To take advantage of the native AIX package installation utility installp, NetWorker 
packages are now installed with the AIX System Management Interface Tool (SMIT) or 
the smitty program. The smitty program is a command line-based software 
management program; SMIT offers the same functionality with a graphical user 
interface. The NetWorker installation program, nsr_ize, is no longer supported.

Important: The AIX installp utility does not enable you to change the default 
installation location of packages. NetWorker binaries are installed to the /usr/bin file 
system. Ensure that you have enough space in the /usr/bin file system for the 
NetWorker binaries. If more space is required and you have enough unallocated disk 
space, the AIX installp utility allocates more space to the /usr/bin file system so that the 
installation completes successfully. For information about the space required for 
NetWorker binaries, see "Space Requirements" on page 20.

You can, however, change the default location for NetWorker configuration files. To 
put these files somewhere other than the default location, which is /nsr, create another 
nsr directory. For example:

mkdir /disk2/nsr

ln -s /disk2/nsr /nsr

Client Installation

To install the NetWorker software on a client computer: 

1. Enter the following command to begin the NetWorker software installation:

smitty install_latest

2. Enter the location of the NetWorker installation software in the [Entry Field].

3. Select the option, SOFTWARE to install.

4. Select F4=List to display the list of NetWorker software packages. 

The following NetWorker installation packages appear: 
• LGTOnw.clnt.rte (client software package)
• LGTOnw.node.rte (storage node software package)
• LGTOnw.serv.rte (server software package)
• LGTOnw.man.rte (optional man pages)
• LGTOnw.licm.rte (optional NetWorker License Manager software package)
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5. Select LGTOnw.clnt.rte to install the NetWorker client software.

6. If required, select LGTOnw.man.rte to install the optional NetWorker man pages.

7. Press Enter to begin the installation.

Note: You might need to install the UTF-8 converters available with your operating 
system. 

Storage Node Installation

To install the NetWorker software on a storage node: 

1. Enter the following command to begin the NetWorker software installation:

smitty install_latest

2. Enter the location of the NetWorker installation software in the [Entry Field].

3. Select the option, SOFTWARE to install.

4. Select F4=List to display the list of NetWorker software packages. 

The following NetWorker installation packages appear: 
• LGTOnw.clnt.rte (client software package)
• LGTOnw.node.rte (storage node software package)
• LGTOnw.serv.rte (server software package)
• LGTOnw.man.rte (optional man pages)
• LGTOnw.licm.rte (optional NetWorker License Manager software package)

5. Select LGTOnw.node.rte to install the NetWorker client software.

6. Select Install and Update Software.

7. If required, select LGTOnw.man.rte to install the optional NetWorker man pages.

8. Press Enter to begin the installation.

Note: You might need to install the UTF-8 converters available with your operating 
system. 

Server Installation

To install the NetWorker software on the computer that is designated as the NetWorker 
server:

1. Keep a copy of the current configuration. The NetWorker software installation 
modifies the following files during the installation process:

• /etc/inittab

• /etc/rc.nsr

• /etc/rpc

• /etc/syslog.conf



EMC Legato NetWorker, Release 7.3, AIX Version
Installation Guide

Chapter 3: Installing NetWorker Software on AIX

24

Copy the current configuration as follows:
cp /etc/inittab /etc/inittab.old

cp /etc/rc.nsr /etc/rc.nsr.old

cp /etc/rpc /etc/rpc.old

cp /etc/syslog.conf /etc/syslog.conf.old

2. Enter the following command to begin the NetWorker software installation:

smitty install_latest

3. Enter the location of the NetWorker installation software in the [Entry Field].

4. Select the option, SOFTWARE to install.

5. Select F4=List to display the list of NetWorker software packages. 

The following NetWorker installation packages appear: 
• LGTOnw.clnt.rte (client software package)
• LGTOnw.node.rte (storage node software package)
• LGTOnw.serv.rte (server software package)
• LGTOnw.man.rte (optional man pages)
• LGTOnw.licm.rte (optional NetWorker License Manager software package)

6. Select LGTOnw.serv.rte to install the NetWorker server software.

7. If required, install the following optional NetWorker software packages:

• NetWorker License Manager software — select LGTOnw.licm.rte

• NetWorker man pages — select LGTOnw.man.rte

8. Press Enter to begin the installation.

Note: You might need to install the UTF-8 converters available with your operating 
system.

Task 3: Change the NetWorker Servers with Access to a Client

To limit the servers authorized to access a client, specify a list of trusted NetWorker 
servers for a client in the /nsr/res/servers file. After installing the client, storage node, 
and server software, use the following procedure to change the NetWorker servers that 
are authorized to access a client.

To change which NetWorker servers can access a client:

1. Shut down the NetWorker daemons:

nsr_shutdown

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one per 
line, that requires access to the client. The first entry in this file becomes the default 
NetWorker server.
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Important: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
• Access and back up the client.
• Perform a directed recover to the client.

3. If necessary, remove the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. Running nsrexecd with the -s option supersedes the 
/nsr/res/servers file:

a. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. The boot-time startup file for the AIX platform is 
/etc/rc.nsr. 

b. If the -s option exists in the boot-time startup file, remove all occurrences of
-s server_name in the startup file.

Task 4: Start the NetWorker Daemons

The NetWorker daemons must be started after the installation procedure. 

1. Start the NetWorker daemons: 

/etc/rc.nsr start

2. Enter the following command at the system prompt:

ps -ef | grep nsr

Table 2 on page 25 lists the NetWorker daemons that should be running.

Note: The NetWorker daemon nsrmmd is only present if one or more devices are 
enabled.

Table 2. NetWorker Daemons

NetWorker Packages NetWorker Daemons

NetWorker server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, 
nsrjobd, nsrmmgd, nsrlcpd

NetWorker client nsrexecd

NetWorker storage node nsrexecd, nsrmmd, nsrlcpd

NetWorker license manager lgtolmd
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Verifying the Installation
This section provides information about testing and verifying the NetWorker software 
installation. To verify that the NetWorker software was installed properly, first connect 
to a NetWorker server, configure a device, and then test the software on the device.

This section includes the following procedures:

• "Task 1: Modify the NetWorker Server Administrator List" on page 26
• "Task 2: Start Console for the First Time" on page 26
• "Task 3: Add a NetWorker Server to the NetWorker Console Server" on page 27
• "Task 4: Configure a Stand-Alone Device" on page 28
• "Task 5: Test the NetWorker Software Installation" on page 29

Task 1: Modify the NetWorker Server Administrator List

You must add the Console administrator to the administrator list of the monitored 
NetWorker server. This enables the the Console administrator to administer and 
monitor the NetWorker server.

On the NetWorker server:

1. At the command line, specify the process owner of the Console service process.

If the Console server is on a:
• Windows host:

nsraddadmin -u "user=SYSTEM, host=console_host"

• Linux, or Solaris only host:
nsraddadmin -u "user=root, host=console_host"

2. Specify the Console administrator user:

nsraddadmin -u "user=administrator, host=console_host"

where console_host is the Console server hostname.

Task 2: Start Console for the First Time

These steps assume that the NetWorker software is installed and that all of the software 
and hardware requirements have been met on the computer that will access Console. 
For information about the Console, see "NetWorker Console Server" on page 12.

To open Console for the first time:

1. Start a web browser session.

2. Enter the URL of the Console server:

http://server_name:http_service_port

where:
– server_name is the name of the computer where the Console server component 

was installed.
– http_service_port is the IP port for the embedded HTTP server. (The HTTP port 

is specified during installation. The default HTTP port is 9000.) For example:
http://houston:9000
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3. From the Welcome page, click Start. 

4. From the Security Warning screen, click Start to install and run NetWorker 
Management Console.

5. If JRE 1.4.2 was not already installed on the system, a prompt to install it appears. 
Follow the on-screen instructions to install JRE.

6. In the NetWorker Management Console Login dialog box, enter the user name and 
password. 

Important: The default user is administrator and the default password for the 
administrator is “administrator”. For security purposes, this password should be 
changed during the first login session.

7. Click OK. The Console Window appears.

How to Start Console after the First Time

After the Console has been started the first time, start it by using any of the following 
methods:

• Point the browser to the same URL as in "Task 2: Start Console for the First Time" 
on page 26.

• Double-click the NetWorker Console product name in the Java Web Start 
Application Manager. 

Task 3: Add a NetWorker Server to the NetWorker Console Server

To add and select a NetWorker server:

1. Start the NetWorker Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon.

4. From the File menu, select New>Host. 

5. Enter a hostname for the NetWorker server. The NetWorker server appears in the 
right pane and left pane.

6. From the left pane, select the NetWorker server.

7. From the right pane, select the NetWorker application.

8. From the Enterprise menu, select Launch Application. The Administration 
window launches.

If the server connection fails, refer to the server connectivity information in the 
NetWorker Administration Guide to troubleshoot the problem.
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Task 4: Configure a Stand-Alone Device

If not already configured, configure a stand-alone device before testing the NetWorker 
software. 

You can configure one of the following stand-alone devices:

• "Stand-Alone Tape Device" on page 28
• "Stand-Alone File or Advanced File Device" on page 28
• "Autochanger or Silo" on page 29

For detailed information about configuring a stand-alone device, refer to the NetWorker 
Administration Guide.

Stand-Alone Tape Device

To configure a stand-alone tape device:

1. In the server’s NetWorker Administration interface, click the Devices button.

2. From the left pane, select Devices.

3. From the left pane, select Storage Nodes.

4. Right-click the storage node to which the device is to be configured.

5. Select Scan for devices. The Scan for Devices window appears.

6. From the list, select the storage node to be scanned.

7. Click Start Scan after filling in the requested information. The new device appears 
in the right pane.

8. From the right pane, select the new device.

9. From the File menu, select Devices>Device Operations>Label. The Label window 
appears.

10. Verify the information in the Label window and click OK.  

Stand-Alone File or Advanced File Device

To configure a stand-alone file or advanced files device:

1. In the server’s NetWorker Administration interface, click the Devices button.

2. From the left pane, select Devices.

3. From the File menu, select New. The Create Devices Window appears.

4. For the Name attribute, enter the device path.

5. For the Media type attribute, select file or adv_file.

6. Click OK. The new device appears in the right pane.

7. From the right pane, select the new device.

8. From the File menu, select Devices>Device Operations>Label. The Label window 
appears.

9. Verify the information in the Label window and click OK.  
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Autochanger or Silo

To configure a new library resource (autochanger or silo) to a storage node: 

1. In the server’s NetWorker Administration interface, click the Devices button.

2. From the left pane, select Storage Nodes.

3. Right-click the storage node to which the device is to be configured.

4. Select Configure All Libraries.

5. Click Start Configuration after filling in the requested information.

6. Click Finish on the configuration window, once the configuration has completed.

Task 5: Test the NetWorker Software Installation

Test a NetWorker installation by performing an ad hoc (manual) backup of a file or 
folder. You can also use the NetWorker Client Configuration Wizard to configure a 
scheduled backup. For detailed information about the wizard, refer to the NetWorker 
Administration Guide.

To test the NetWorker software on a stand-alone device:

1. Start the NetWorker Management Console software and then start the NetWorker 
nwbackup program. 

To start the NetWorker nwbackup program:
a. From the Administration window, click Monitoring.
b. From the Monitoring menu, select Launch NetWorker User Application. The 

NetWorker Backup window appears.
The NetWorker nwbackup program provides a graphical interface through which 
ad hoc (manual) backups are performed. For general information about the 
NetWorker nwbackup program, see the NetWorker Administration Guide.

2. From the NetWorker nwbackup program, select Launch Backup.

a. In the left pane of the Backup window, click the appropriate directory folder. 
b. Select each directory and/or file you intend for manual backup by 

performing one of the following:
– Select the directory or file and click the Mark button. To clear an item, 

click the Unmark button.
– Click the directory or file.
When you mark a directory or file for backup, a check mark appears next to 
that item.

c. Click the Start button to begin the ad hoc backup.
The Backup Status dialog box displays the progress of the backup. When the 
NetWorker server has successfully finished the backup, the nwbackup 
program displays the following (or a similar) message:
Backup completion time: 2-15-03 3:27p

Note: If the backup fails, an error message will appear. Error messages are also 
written to the NetWorker log file. If the test backup was not successfully 
completed, refer to the troubleshooting information in the NetWorker 
Administration Guide to determine the cause.
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Uninstalling the NetWorker Software
Use SMIT to uninstall individual NetWorker software packages or all of the NetWorker 
packages at the same time. 

To uninstall the NetWorker software:

1. Log in as root on the computer where the software is being removed.

2. Enter the nsr_shutdown command to shut down the NetWorker daemons. 

A list of NetWorker daemons appears. A prompt asks whether to continue with the 
nsr_shutdown command. 

3. Enter the following command to remove the NetWorker software:

smitty remove

4. Select F4=List to display a list of NetWorker software packages.

5. Select the NetWorker software packages to remove:

• Client software — select LGTOnw.clnt.rte

• Storage node software — select LGTOnw.node.rte

• Server software — select LGTOnw.serv.rte

• Man pages — select LGTOnw.man.rte 
• License Manager software — select LGTOnw.licm.rte

6. Press Enter to uninstall the NetWorker software.

7. Exit the SMIT program.
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Chapter 4: Installing NetWorker Software in an
HACMP for AIX Environment

This chapter explains how to install NetWorker software in a High Availability Cluster 
Multiprocessing for AIX (HACMP for AIX) environment. It includes the following 
sections:

• "Software Installation Roadmap" on page 31
• "Installation Requirements" on page 32
• "Installing a NetWorker Virtual Server" on page 34
• "Installing Only the NetWorker Client Software in a Cluster" on page 39
• "Configuring an External Client to a Virtual Server" on page 41
• "Scheduling Saves for Raw Volumes" on page 42
• "Tracking Scheduled Saves" on page 42
• "Uninstalling the NetWorker Software" on page 43
• "NetWorker Cluster Script" on page 44

An HACMP for AIX cluster consists of multiple RS/6000 processors (physical nodes) 
in a network configuration. It provides additional security with failover capability. 
Failover allows another node in the cluster to take over operations from the first node.

Software Installation Roadmap
Use the following roadmap when installing NetWorker software:

1. Review the requirements section and note the default directory locations. See 
"Installation Requirements" on page 32.

2. Install the required NetWorker software. See one of the following sections:

• "Installing a NetWorker Virtual Server" on page 34
• "Installing Only the NetWorker Client Software in a Cluster" on page 39

3. Enable and register all of the NetWorker products. See "Chapter 6: Evaluating and 
Licensing NetWorker Software" on page 58.
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Installation Requirements
The following sections discuss the software and hardware required to install and 
configure the NetWorker server or client software within an HACMP for AIX 
environment:

• "Software Requirements" on page 32
• "Hardware Requirements" on page 32
• "Configuration Options" on page 33
• "System Information Requirements" on page 33

For the most up-to-date information regarding requirements, refer to the Legato 
Compatibility Guides.

Software Requirements

To install a NetWorker cluster server, ensure that the following software is installed on 
each node in the cluster:

• AIX Release 4.3.x or later
• HACMP for AIX release 4.5 or later (this requires a persistent IP address for each 

physical node)
• NetWorker release 7.0 or later

Hardware Requirements

To install the NetWorker software, ensure that the following hardware requirements 
are met:

• A dedicated shared volume group and filesystem used as the NetWorker storage 
area (for the /nsr directory) connected to all the nodes within the cluster (for 
server installation only).

• A device with local affinity for the local bootstrap backup connected to all the 
nodes within the cluster (for server installation only).

For clusters configured with IP address takeover (IPAT), connect to a computer 
through its boot address if a resource group is not defined. Service addresses are 
associated with a resource group, not physical nodes. 

The output of the hostname command on a machine must correspond to an IP address 
that can be pinged. The machine hostname must also be set to the name equivalent of 
the address used by the physical client’s dedicated NIC. This NIC should be 
configured as the primary network adapter, for example, en0.

An extra NIC outside of the control of HACMP for AIX is not required to enable a 
highly available NetWorker server.
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Configuration Options

For information on how to configure the following, refer to the NetWorker 
Administration Guide:

• Tape libraries with a NetWorker virtual server
• Remote physical storage nodes with a NetWorker virtual server

System Information Requirements

Figure 1 on page 34 illustrates a sample cluster configuration and Table 3 on page 33, 
displays the system information needed to install NetWorker software within an 
HACMP for AIX cluster environment.

The following terms are used to define HACMP for AIX cluster concepts: 

• Node name—The HACMP for AIX defined name for a physical node. 
• Boot address—The address used by a node when it boots up, but before HACMP 

for AIX starts.
• Service address—The address used by highly available services in an HACMP for 

AIX environment.
• Virtual client— The client associated with a highly available resource group. The 

filesystem defined in a resource group belongs to a virtual client. The virtual 
client uses the service address.

Note: The HACMP for AIX resource group must contain an IP service label to be 
considered a NetWorker virtual client.

• Physical client—The client associated with a physical node. For example the / and 
/usr filesystems belong to the physical client.

• Physical host address (physical hostname)—The address used by the physical client. 
For HACMP for AIX 4.5, this is equivalent to a persistent IP address.

Table 3. Required Cluster Information

Information Required Example

NetWorker virtual name with an 
IP addresses

clus_vir1
191.168.1.10

Physical address for Node 1 191.168.1.20

Physical address for Node 2 191.168.1.30

NetWorker package mount point for virtual volume /nsr_shared_mnt_pt

NetWorker control script /usr/bin/nw_hacmp.lc

File containing the hostids of all the cluster members /nsr/res/hostids



EMC Legato NetWorker, Release 7.3, AIX Version
Installation Guide

Chapter 4: Installing NetWorker Software in an HACMP for AIX Environment

34

Figure 1. Sample Cluster Configuration with Private Network

Installing a NetWorker Virtual Server
Use the following roadmap to install and configure the NetWorker software as a highly 
available service in an HACMP for AIX environment:

• "Task 1: Install the NetWorker Software in a Cluster" on page 35
• "Task 2: Define the Server as Highly Available" on page 35
• "Task 3: Define an HACMP for AIX NetWorker Server" on page 35
• "Task 4: Grant Access to the NetWorker Virtual Server" on page 36
• "Task 5: Configure the NetWorker Cluster Server" on page 37
• "Task 6: Configure Clients under the NetWorker Cluster Server" on page 38
• "Task 7: Register NetWorker Licenses for Virtual Server Failover" on page 39
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Task 1: Install the NetWorker Software in a Cluster

To install the NetWorker software in a cluster:

1. Ensure that the most recent HACMP for AIX patch is installed.

2. Install the following NetWorker software packages on each node in the cluster:

• Client
• Driver
• Storage node
• Server

For detailed instructions on installing the NetWorker software, see 
"Chapter 3: Installing NetWorker Software on AIX" on page 17.

Task 2: Define the Server as Highly Available

To define and configure the NetWorker server as highly available:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the virtual 
host. The virtual hostname in the DNS or NIS can be published.

3. From each node in the cluster that will run the NetWorker server process:

a. Run the cluster configuration script, networker.cluster, located in the /usr/bin/ 
directory.

b. Enter the following information:
– Location of the local NetWorker database directory provided during the 

installation procedure: /nsr

– Published virtual hostname: clus_vir1

– Shared nsr mount directory: /nsr_shared_mnt_pt

Note: Any configuration can be undone by running the networker.cluster -r 
option.

4. Verify that the following values are set:

NSR_SERVERHOST = virtual hostname (clus_vir1)

NSR_SHARED_DISK_DIR = shared nsr mount directory (/nsr_shared_mnt_pt)

Task 3: Define an HACMP for AIX NetWorker Server 

To define an HACMP for AIX NetWorker server:

1. Create a shared filesystem.

2. Define a service IP label.
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3. Define a NetWorker application service:

a. Enter the following command as root:
smit hacmp

b. From the main window, select the following options: 
Cluster Configuration>Cluster Resource>Define Application Server>Add an 
Application Server.

c. Complete the following as shown:
Server name: networker

Start script: /usr/bin/nw_hacmp.lc start
Stop script: /usr/bin/nw_hacmp.lc stop
This application server will be used by the NetWorker resource group.

4. Configure a NetWorker resource group.

For detailed instructions on defining and monitoring a resource group in an HACMP 
for AIX environment, refer to the HACMP for AIX documentation.

Task 4: Grant Access to the NetWorker Virtual Server

Before a NetWorker server can back up a client, the server must have access to the 
client. Granting access to the server is controlled by editing the /nsr/res/servers file. 

Important: If the /nsr/res/servers file is empty or does not exist, any NetWorker server 
can back up a client. Only servers listed in the /nsr/res/servers file can back up a client.

To grant access to the NetWorker virtual server:

1. On each node in the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped.

b. Edit or create the /nsr.NetWorker.local/res/servers file:
– Add the set of NetWorker servers, one per line, that require access to this 

client.
– For each virtual NetWorker server, add an entry for each physical host 

and the NetWorker virtual server. For example:
clus_vir1

clus_phys1

clus_phys2

c. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. If the -s option exists, remove all occurrences of 
-s server_name in the file.
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2. On one node in the cluster, start the NetWorker service by using the cluster 
management software.

a. Use the HACMP for AIX software to bring the NetWorker resource group 
online.

b. Edit or create the /nsr/res/servers file:
– Add the set of NetWorker servers, one per line, that require access to the 

client.
– For each virtual NetWorker server, add an entry for each physical host 

and the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

3. If required, grant access to each NetWorker client that is outside of the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped:
nsr_shutdown

ps -ef | grep nsr

b. Edit or create the /nsr/res/servers file:
– Add the set of NetWorker servers, one per line, that require access to the 

client.
– For each virtual NetWorker server, add an entry for each physical host 

and the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

Task 5: Configure the NetWorker Cluster Server

To configure the NetWorker server:

1. Log in as root on the cluster node that is running the NetWorker virtual server.

2. Start the NetWorker Console software.

a. From the Console window, click Enterprise.
b. From the left pane, select the Enterprise icon. The NetWorker server appears 

in the right pane and left pane.
c. From the left pane, select the NetWorker server.
d. From the right pane, select the NetWorker application.
e. From the Enterprise menu, select Launch Application. The Administration 

window launches. 
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3. From the Administration window, click Configuration.

a. In the left pane, select the NetWorker server. 
b. From the File menu, select Properties. The Properties dialog box appears.

– For the Administrator attribute, add entries for any cluster nodes that are 
not already listed. For example:
root@hostname

– Click OK.

Task 6: Configure Clients under the NetWorker Cluster Server

When the networker.cluster script runs, it creates a symbolic link named /nsr that 
points to a local disk. It also creates a second link named nsr.NetWorker.local that points 
to the local NetWorker directory. For example, if the local NetWorker directory was 
created in /var/nsr, each client member has the following links:

• /nsr->/nsr.NetWorker.local

• /nsr.NetWorker.local->/var/nsr

To configure clients under the NetWorker cluster server:

1. (Optional) Define savegroups as needed.

Important: Savegroups must have the Autorestart attribute enabled and the Manual 
Restart option disabled in order for their save sets to restart after a virtual client or 
NetWorker server failover.

2. Make each physical Client within the cluster a NetWorker client of the NetWorker 
server. 

For each physical client in the cluster:
a. Create a new NetWorker client.
b. Enter the name of the physical Client for the Name attribute.
c. Add the boot adaptor name in the Aliases list. 

For more information, refer to the NetWorker Administration Guide.

3. Make each virtual client within the cluster a NetWorker client of the virtual 
NetWorker server. 

For each virtual client in the cluster:
a. Create a new NetWorker client.
b. Enter the name of the service address for the Name attribute.
c. For the Remote Access attribute, the user must be the root user for the boot 

address. Add entries for each service, boot, and physical address defined 
within the cluster. For example:
root@clus_phys1
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d. For the Group attribute, select a group.
For more information, refer to the NetWorker Administration Guide.

4. Run a test probe to verify that the client and group resources have been properly 
configured.

On the node on which the NetWorker server resides, run the following command:
savegrp -pv -c client_name group_name

5. If the test probe does not display the scheduled backups and index, see "Tracking 
Scheduled Saves" on page 42.

Task 7: Register NetWorker Licenses for Virtual Server Failover

To register a NetWorker server in a cluster environment:

1. Ensure that the NetWorker virtual server is defined as a part of the cluster.

2. Ensure that the NetWorker service is running.

3. For each physical node in the cluster:

a. Relocate, sequentially, the NetWorker server to this node.
b. From the NetWorker Administration window, note the host ID number for 

the appropriate cluster license.

4. Log on to the system running the NetWorker virtual server and create a file named 
/nsr/res/hostids that contains the host IDs of all the cluster nodes. Use the following 
syntax: hostid1:hostid2:hostid3:... 

For example: 12345678:87654321

5. Restart the server by taking the NetWorker virtual server offline and then putting 
it back online.

6. From the NetWorker Administration window, note the host ID number for the 
appropriate cluster license.

7. Register the NetWorker software. 

Customer Service sends you the authorization codes by using the composite host ID 
that was created in step 6.

Installing Only the NetWorker Client Software in a Cluster
Use the following roadmap to install a NetWorker cluster client:

• "Task 1: Install the NetWorker Cluster Client Software" on page 40
• "Task 2: Configure the NetWorker Client Software as Highly Available" on 

page 40
• "Task 3: Define the List of Trusted NetWorker Servers" on page 40
• "Task 4: Configure Clients under the NetWorker Server" on page 41

Important: Ensure that the NetWorker client software is installed on every node in the 
cluster that needs to be backed up.
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Task 1: Install the NetWorker Cluster Client Software

To install the NetWorker client software on each node in the cluster:

1. Ensure that the most recent HACMP for AIX patch is installed.

2. Install the NetWorker client software on every node in the cluster to be backed up. 

For detailed instructions about installing the NetWorker software, see 
"Chapter 3: Installing NetWorker Software on AIX" on page 17.

Task 2: Configure the NetWorker Client Software as Highly Available

To define and configure a NetWorker client as highly available:

1. Log in as root on each node where the NetWorker software is being installed.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the virtual 
host. The virtual hostname in a DNS or NIS can be published.

3. For each node in the cluster:

a. Run the cluster configuration script, networker.cluster.
b. When prompted to configure the NetWorker server, enter No.

Note: If the configuration is not correct, any configuration can be undone by running 
the networker.cluster -r option.

For an example of the script, see "NetWorker Cluster Script" on page 44.

Task 3: Define the List of Trusted NetWorker Servers

Before a NetWorker server can back up a client, the client must grant the server access. 
Granting access is controlled by the /nsr/res/servers file. If this file does not exist, any 
NetWorker server can back up this client. If this file does exist, only the specific servers 
listed in it, can back up the client.

To define the list of trusted NetWorker servers, perform the following steps on each 
node in the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker daemons have 
stopped.

2. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

3. Check the NetWorker boot-time startup file to see whether nsrexecd is being run 
with the -s option. If the -s option exists, remove all occurrences of -s server_name in 
the file.
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Task 4: Configure Clients under the NetWorker Server

To configure the NetWorker server:

1. Make each physical client within the cluster a NetWorker client of the NetWorker 
server. 

For each physical client in the cluster:
a. Create a NetWorker new client.
a. Enter the name of the physical Client for the Name attribute.
b. Add the boot adaptor name in the Aliases list. 

Note: If a physical Client is backed up to a NetWorker server outside the cluster, 
the name of any virtual service that can run on the physical node must be added 
to the Remote Access list of the physical Client property sheet.

2. Make each virtual client within the cluster a client of the NetWorker server.

For each virtual client in the cluster:
a. Create a new NetWorker client.
b. For the Name attribute, enter the name of the NetWorker server.
c. For the Remote Access attribute, add entries for each service, boot, and 

physical address defined within the cluster. For example:
root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using the NetWorker application. 

Note: The NetWorker server might reside outside of the cluster. 

Configuring an External Client to a Virtual Server
If required, use the following procedure to configure and back up an external client to 
a NetWorker virtual server.

Before a NetWorker server can back up a client, the client must grant the server access. 
Granting access is controlled by the /nsr/res/servers file. If this file does not exist, any 
NetWorker server can back up this client. If this file does exist, only the specific servers 
listed in it, can back up the client.

On each NetWorker client that is outside of the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker daemons have 
stopped.

2. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2
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Scheduling Saves for Raw Volumes
To enable NetWorker scheduled saves of raw volumes that are owned by a resource 
group (virtual client), flag the logical volume: 

1. Ensure that the volume group to which the logical volume belongs appears under 
Volume Groups in the resource group configuration.

2. Set the logical volume type to raw by using the chlv command. For example:

chlv -t 'raw' logical_volume_name

In the following example, the logical volume ha_rv, that belongs to the volume group 
havg, will be used as a raw device:

chlv -t’raw’ ha_rv

lsvg -l havg

havg:

Note: The NetWorker software does not support raw volumes used for concurrent 
access.

Tracking Scheduled Saves
To verify that the Client and Group resources are properly configured, run a test probe 
for each client from the node where the NetWorker application is running:

savegrp -pv -c client_name group_name

If the test probe does not display all the scheduled save sets:

• Check the cluster configuration by using the cluster management software. If 
necessary, reconfigure the cluster.

• Ensure that the save sets defined for the client are owned by that client. If 
necessary, redistribute the client save sets to the appropriate Client resources. 

Important: Misconfiguration of the cluster resources might cause scheduled save sets 
to be dropped from the backup. For more information, refer to the NetWorker 
Administration Guide.

• Run the following command to override scheduled save rules (not path 
ownership rules):
touch networker_bin_dir/pathownerignore

• Run a second test probe to verify the configuration.

LV NAME TYPE LPs PPs PVs LV STATE
MOUNT 
POINT

ha_rv raw 10 10 1 closed/syncdN/A

ha_fs jfs 38 38 1 closed/syncd/share/web
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This command allows any path to be backed up for a client, whether it is owned by the 
virtual client or physical node. For detailed information, see the NetWorker 
Administration Guide.

If the pathownerignore command was used, check that the NetWorker scheduled save 
uses the correct client index. If the wrong index is used, the savesets can be forced to 
go to the correct index:

1. From the NetWorker Administration window, select a client and edit its properties.

2. For the Backup command attribute, enter the name of a backup script that contains 
save -c client_name. 

For detailed information about the Backup command attribute, refer to the NetWorker 
Administration Guide.

Uninstalling the NetWorker Software
To uninstall the NetWorker software from a cluster environment: 

1. If necessary, use the cluster management software to stop the NetWorker server 
services.

2. Shut down the client services on the node that the NetWorker software is being 
removed from:

nsr_shutdown

A list of NetWorker services appears and a prompt asks whether to continue with 
the nsr_shutdown command.

3. Run the following command:

/usr/bin/networker.cluster -r

4. Use SMIT to uninstall individual NetWorker software packages or all of the 
NetWorker packages at the same time. 

5. To uninstall the NetWorker software, log in as root on the computer where the 
software is being removed.

6. Enter the following command to remove the NetWorker software:

smitty remove

7. Select F4=List to display a list of NetWorker software packages.

8. Select the NetWorker software packages to remove:

• Client software—select LGTOnw.clnt.rte

• Storage node software—select LGTOnw.node.rte

• Server software—select LGTOnw.serv.rte

• Manpages—select LGTOnw.man.rte 
• License Manager software—select LGTOnw.licm.rte

9. Press [Return] to uninstall the NetWorker software.

10. Exit the SMIT program.
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NetWorker Cluster Script
This example, generated when the networker.cluster script runs, uses the following 
configuration:

• Virtual server: clus_vir1

• Virtual server IP address: 192.168.1.10

• Mount point: /nsr_shared_mnt_pt

---------------------------------------------------------------

HACMP is a highly available product for AIX.

It defines failover applications which may move from one node to

another, depending on the availability and health of the machine

it is running upon.

---------------------------------------------------------------

Do you wish to continue? [Yes]? 

Enter directory where local NetWorker database is installed 
[/nsr]? /usr/nsr

Do you wish to configure for both NetWorker server and client?

Yes or No [Yes]? yes

Do you wish to add now the site-specific values for:

NSR_SHARED_DISK_DIR and NSR_SERVERHOST in /usr/bin/nw_hacmp.lc

Yes or No [Yes]? yes

Enter the published Service IP Label to be used for NetWorker? 
baryon

The mountpoint of the shared NetWorker directory (the nsr 
directory) must be the same for all the nodes where NetWorker 
server can failover to.

In what path will this nsr directory be created/located? /share

/usr/bin/nw_hacmp.lc has been modified

Creating /usr/bin/lcmap file ...

-rwxrwxr-x   1 root     system      2270 Dec  4 14:08 /usr/bin/lcmap

Finished creating /usr/bin/lcmap file.

NetWorker has been successfully cluster-configured.
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Chapter 5: Installing NetWorker Software in an EMC
FullTime AutoStart Environment

This chapter explains how to install NetWorker software in an EMC FullTime 
AutoStart™ environment (formerly Legato Automated Availability Manager™). It 
includes the following sections:

• "Software Installation Roadmap" on page 45
• "Installation Requirements" on page 46
• "Installing a NetWorker Virtual Server" on page 48
• "Installing Only the NetWorker Client Software in a Cluster" on page 53
• "Configuring an External Client to a Virtual Server" on page 55
• "Defining Ownership of a Raw Partition for Virtual Clients" on page 56
• "Tracking Scheduled Saves" on page 56
• "Uninstalling the NetWorker Software" on page 57

A FullTime AutoStart cluster consists of multiple nodes in a networked configuration 
and provides additional security with the failover capability. Failover allows another 
node in the cluster to take over operations from the first node. For information, refer to 
the FullTime AutoStart documentation on the Legato website.

Software Installation Roadmap
The following tasks are a roadmap to follow when installing the NetWorker software:

1. Review the requirements section and note the default directory location. See 
"Installation Requirements" on page 46.

2. Install the required NetWorker software. See one of the following sections:

• "Installing a NetWorker Virtual Server" on page 48
• "Installing Only the NetWorker Client Software in a Cluster" on page 53

3. Enable and register all of the NetWorker products. See "Chapter 6: Evaluating and 
Licensing NetWorker Software" on page 58.
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Installation Requirements
The following sections discuss the software and hardware required to install and 
configure the NetWorker server or client software within a FullTime AutoStart cluster 
environment:

• "Software Requirements" on page 46
• "Hardware Requirements" on page 46
• "Configuration Options" on page 46
• "System Information Requirements" on page 47

For the most up-to-date information regarding software and hardware requirements, 
refer to the Legato Compatibility Guides.

Software Requirements

To install NetWorker cluster server, ensure that the following software is installed on 
each node in the cluster:

• AIX release 5.1 or later
• FullTime AutoStart release 5.1 or later
• NetWorker release 7.3

Note: Ensure that the most recent cluster patch for the operating system is installed.

Hardware Requirements 

To install the NetWorker software, ensure that the following hardware requirements 
are met for server installation only:

• Dedicated shared disk used as the NetWorker storage disk (for the /nsr directory) 
connected to all the nodes within the cluster.

• Device with local affinity for the local bootstrap backup connected to all the nodes 
within the cluster.

Configuration Options

Refer to the NetWorker Administration Guide for information on how to configure:

• Tape libraries with a NetWorker virtual server
• Remote physical storage node with a NetWorker virtual server
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System Information Requirements

Figure 2 on page 47 illustrates a sample cluster configuration and Table 4 on page 47 
display the system information needed to install NetWorker software within a 
FullTime AutoStart environment.

Different operating systems use different terms for the same cluster concepts. FullTime 
AutoStart refers to:

• Physical hosts as nodes
• Virtual server as a resource group (application service)

Figure 2. Sample Cluster Configuration

Table 4. Required System Information

Information Required Example

NetWorker virtual hostname with an IP address clus_vir1
192.168.1.10

NetWorker package mount point for virtual volume /nsr_shared_mnt_pt

Shared storage disk virtual volume /dev/lv1

NetWorker control script /usr/bin/nw_ux.lc

File containing the hostids of all the cluster members /nsr/res/hostids

NetWorker monitor script /usr/bin/nw_ux.lc

Local
Disk 1

Shared Disks 3

Node B
clus_phys2

Node A
clus_phys1

Local
Disk 2

Public Network

NetWorker Virtual Server

(If Node A fails, 
clus_vir1 fails 

over to Node A)
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Installing a NetWorker Virtual Server
Use the following roadmap to install and configure the NetWorker software as a highly 
available service in a cluster:

• "Task 1: Ensure that the FullTime AutoStart Software is Installed"
• "Task 2: Install the NetWorker Software in a Cluster" on page 48
• "Task 3: Define the NetWorker Server as Highly Available" on page 48
• "Task 4: Grant Access to the NetWorker Virtual Server" on page 50
• "Task 5: Configure the NetWorker Server" on page 51
• "Task 6: Configure Clients under the NetWorker Virtual Server" on page 51
• "Task 7: Register NetWorker Licenses for Virtual Server Failover" on page 52

Task 1: Ensure that the FullTime AutoStart Software is Installed

Ensure that the FullTime AutoStart software is installed. For detailed installation 
instructions, refer to the FullTime AutoStart documentation.

For EMC FullTime AutoStart Release 5.1.2, you must install the following hotfix: 

ftp.legato.com/pub/cluster/patches/5.1/unix

Task 2: Install the NetWorker Software in a Cluster

To install the NetWorker software:

1. Ensure that the most recent cluster patch for the operating system is installed.

2. Install the following NetWorker software on each node in the cluster:

• NetWorker Client
• Storage Node
• NetWorker Server
For detailed instructions, see "Installing the NetWorker Software" on page 21.

Task 3: Define the NetWorker Server as Highly Available

To define and configure the NetWorker server as highly available:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the virtual 
host. The virtual hostname in the Domain Name System (DNS) or Network 
Information Services (NIS) can be published.
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3. Set and export the FT_DIR, FT_DOMAIN, and the FT_CONSOLE_DIR 
environment variables. For example, enter the following commands from the 
Bourne shell:

FT_DIR=/usr/lpp/LGTOaam51

FT_CONSOLE_DIR=$FT_DIR/console 

FT_DOMAIN=domain_name

export FT_DIR FT_DOMAIN FT_CONSOLE_DIR

where domain_name is the FullTime AutoStart domain.

4. From each node in the cluster that will run the NetWorker server process:

a. Run the cluster configuration script, networker.cluster, located in the /usr/bin/ 
directory.

b. Enter the following information:
– Location of the local NetWorker database directory provided during the 

installation procedure: /nsr

– Published virtual hostname: clus_vir1

– Shared nsr mount directory: /nsr_shared_mnt_pt

Note: Any configuration errors can be undone by running the networker.cluster 
-r option.

5. From one node in the cluster:

a. Log in as administrator.
b. Customize the /usr/bin/nw_ux.lc.imp file. The nw_ux.lc.imp file can be used to 

create the NetWorker resource group and its dependant objects in one step.

Important: Instances in the nw_ux.lc.imp file (in the /usr/bin/ directory) of the “NW 
Customize” comment must be replaced with the appropriate cluster configuration 
values.

Follow the instructions listed in the comments at the beginning of the 
nw_ux.lc.imp file to customize the following NetWorker default values based 
on the cluster configuration:
– Virtual host’s IP address: 192.168.1.10

– Physical hostnames: clus_phys1, clus_phys2

– Shared disk file system: /nsr_shared_mnt_pt

– Device name: /dev/1v1

For a list of the sample values provided, see Table 4 on page 47.
c. At the command line, enter the following command:

$FT_DIR/bin/ftcli -c “import /usr/bin/nw_ux.lc.aam5.imp”

d. Use the FullTime AutoStart Management Console to verify that the 
NetWorker resource group was imported correctly.

e. Run the following script located in the /usr/bin directory:
nwinst.sh
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Task 4: Grant Access to the NetWorker Virtual Server

Before a NetWorker server can back up a client, the server must have access to the 
client. Access is granted by editing the /nsr/res/servers file. 

Important: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
• Access and back up the client.
• Perform a directed recover to the client.

To grant access to the NetWorker virtual server:

1. On each node in the cluster:

a. Shut down the NetWorker services.
b. Edit or create the /nsr.Networker.local/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– For each virtual NetWorker server, add an entry for each physical host 
and the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

c. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. If the -s option exists, remove all occurrences of 
-s server_name in the file.

2. If required, grant access to each NetWorker client that is outside of the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker services 
have stopped.

b. Edit or create the /nsr/res/servers file:
– Add the NetWorker servers, one per line, that require access to this client.
– For each virtual NetWorker server, add an entry for each physical host 

and the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2
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Task 5: Configure the NetWorker Server

To configure the NetWorker server:

1. Log in as root on the cluster node that is running the NetWorker virtual server and 
start the NetWorker software:

nsradmin -s clus_vir1

2. From the Administration window, select Properties from the File menu.

a. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example:
root@hostname

b. Click OK.

Task 6: Configure Clients under the NetWorker Virtual Server

When the networker.cluster script runs, it creates a symbolic link named /nsr that 
points to a local disk. It also creates a second link named nsr.NetWorker.local that points 
to the local NetWorker directory. For example, if the local NetWorker directory was 
created in /var/nsr, each client member has the following links:

• /nsr->/nsr.NetWorker.local

• /nsr.NetWorker.local->/var/nsr

To configure each client under the NetWorker server:

1. (Optional) Define save groups as required.

Important: Save groups must have the Autorestart attribute enabled and the Manual 
Restart option disabled in order for their save sets to restart after a virtual client or 
NetWorker server failover.

2. Make each physical Client within the cluster a NetWorker client of the NetWorker 
server. 

For each physical client in the cluster:
a. Create a new NetWorker client.
b. For the Name attribute, enter the name of the physical client.

For more information, refer to the NetWorker Administration Guide.

3. Make each virtual client within the cluster a NetWorker client of the virtual 
NetWorker server. 

For each virtual client in the cluster:
a. Create a new NetWorker client.
b. For the Name attribute, enter the name of the virtual client.
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c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example:
root@clus_phys1

d. For the Group attribute, select a group.
The first time the NetWorker application runs, it creates the Client resource for the 
NetWorker virtual server. For more information, refer to the NetWorker 
Administration Guide.

4. On each node that the logical volume can be attached, check that the /etc/filesystems 
file contains the same mount point for the logical volume as the one specified in 
the FullTime AutoStart Resource group. If the mount points differ, change the 
entry in the /etc/filesystems file.

To change the entry for the logical volume mount point in the /etc/filesystems file, 
run the following command:
chfs -n new_mountpoint old_mountpoint

5. Run a test probe to verify that the Client and Group resources have been properly 
configured.

On the node on which the NetWorker server resides, run the following command:
savegrp -pv -c client_name group_name

If the test probe does not display the correct scheduled backups and index, see 
"Tracking Scheduled Saves" on page 56.

Task 7: Register NetWorker Licenses for Virtual Server Failover

To register a NetWorker server in a cluster environment:

1. Ensure that the NetWorker virtual server is defined as a part of the cluster.

2. Ensure that the NetWorker service is running.

3. For each physical node in the cluster:

a. Relocate, sequentially, the NetWorker server to this node.
b. From the NetWorker Administration window, note the host ID number for 

the appropriate cluster license.

4. Log on to the system running the NetWorker virtual server and create a file named 
/nsr/res/hostids that contains the host IDs of all the cluster nodes. Use the following 
syntax: hostid1:hostid2:hostid3:... 

For example: 12345678:87654321

5. Restart the server by taking the NetWorker virtual server offline and then putting 
it back online.

6. From the NetWorker Administration window, note the host ID number for the 
appropriate cluster license.

7. Register the NetWorker software. 

Customer Service will send you authorization codes by using the composite host ID 
that was created in step 4.
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Installing Only the NetWorker Client Software in a Cluster
Use the following roadmap to install the NetWorker cluster client:

• "Task 1: Install the NetWorker Cluster Client Software" on page 53
• "Task 2: Configure the NetWorker Client Software as Highly Available" on 

page 53
• "Task 3: Define the List of Trusted NetWorker Servers" on page 54
• "Task 4: Configure Clients under the NetWorker Server" on page 54

Task 1: Install the NetWorker Cluster Client Software

To install the NetWorker software on each node in the cluster:

1. Ensure that the most recent FullTime AutoStart patch is installed.

2. Install the NetWorker client software on every node in the cluster to be backed up. 
For detailed instructions, see "Installing the NetWorker Software" on page 21.

Task 2: Configure the NetWorker Client Software as Highly Available

To define and configure a NetWorker client as highly available:

1. Log in as root on each node where the NetWorker software is being installed.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the virtual 
host. The virtual hostname can be published in a DNS or NIS.

3. Set and export the FT_DIR, FT_DOMAIN, and FT_CONSOLE_DIR environment 
variables. For example, use the following commands from the Bourne shell:

FT_DIR=/usr/lpp/LGTOaam51

FT_CONSOLE_DIR=$FT_DIR/console 

FT_DOMAIN=domain_name

export FT_DIR FT_DOMAIN FT_CONSOLE_DIR

where domain_name is the FullTime AutoStart domain.

4. For each node in the cluster:

a. Run the cluster configuration script, networker.cluster, located in the /usr/bin/ 
directory. 

b. When prompted to configure the NetWorker server, enter No.
Note: Any configuration errors can be undone by running the networker.cluster 
-r option. 
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Task 3: Define the List of Trusted NetWorker Servers

Before a NetWorker server can back up a client, the client must grant the server access. 
Access is granted by editing the /nsr/res/servers file. 

Important: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
• Access and back up the client.
• Perform a directed recover to the client.

To define the list of trusted NetWorker servers, perform the following steps on each 
node in the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker services have 
stopped.

2. Edit or create the /nsr/res/servers file:

a. Add the NetWorker servers, one per line, that require access to this client.
b. For each virtual NetWorker server, add an entry for each physical host and 

the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

3. Check the NetWorker boot-time startup file to see whether nsrexecd is being run 
with the -s option. 

If the -s option exists, remove all occurrences of -s server_name in the file.

Task 4: Configure Clients under the NetWorker Server

To configure the NetWorker server:

1. Make each physical client within the cluster a NetWorker client of the NetWorker 
server. 

For each physical client in the cluster:
a. Create a NetWorker new client.
b. For the Name attribute, enter the name of the physical client.

Note: If a physical Client is backed up to a NetWorker server outside the cluster, 
the name of any virtual service that can run on the physical node must be added 
to the Remote Access list of the physical Client resource.
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2. Make each virtual client within the cluster a client of the NetWorker server.

For each virtual client in the cluster:
a. Create a new NetWorker client. 
b. For the Name attribute, enter the name of the NetWorker server.
c. For the Remote Access attribute, add entries for each physical client within 

the cluster. For example:
root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using the NetWorker application. 

Note: The NetWorker server might reside outside of the cluster. 

Configuring an External Client to a Virtual Server
Use the following procedure to configure and back up an external NetWorker client to 
a highly available NetWorker server.

Before a NetWorker server can back up a client, the client must grant the server access. 
Access is granted by editing the /nsr/res/servers file. 

Important: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
• Access and back up the client.
• Perform a directed recover to the client.

On each NetWorker client that is outside of the cluster:

1. Shut down the NetWorker services.

2. Edit or create the /nsr/res/servers file:

a. Add the NetWorker servers, one per line, that require access to this client.
b. For each virtual NetWorker server, add an entry for each physical host and 

the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2
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Defining Ownership of a Raw Partition for Virtual Clients
To back up the raw partitions of a NetWorker virtual client, use the IPOverride option 
in the FullTime AutoStart Management Console.

1. Open the FullTime AutoStart Console and select Resource Group. The Resource 
Group Editor window appears.

2. Select the Edit View tab and then select Attributes from the Edit menu. The Define 
Resource Group Attributes dialog box appears.

3. Add the following line in the Define Resource Group Attributes text box: 

IPOverride=IP_address=raw_partition_path

For example: IPOverride=135.69.103.149=/dev/rdsk/c1t3d0s1

Note: The IPOverride option does not add to the normal list of virtual client-owned 
paths, but completely overrides them. In the above example, if the virtual client also 
owns the file system /share/web, set the following path:

IPOverrride=135.69.103.149=/dev/rdsk/c1t3d0s1, /share/web

Tracking Scheduled Saves
To verify that the Client and Group resources are properly configured, run a test probe 
for each client from the node where the NetWorker application is running:

savegrp -pv -c client_name group_name

Important: Misconfiguration of the cluster resources might cause scheduled save sets 
to be dropped from the backup. For more information, refer to the NetWorker 
Administration Guide.

If the test probe does not display all the scheduled save sets: 

• Check the cluster configuration by using the FullTime AutoStart Management 
Console. If necessary, reconfigure the cluster.

• Ensure that the save sets defined for the client are owned by that client. If 
necessary, redistribute the client save sets to the appropriate Client resources. 

• Run the following command to override scheduled save rules (not path 
ownership rules), on each node in the cluster:
touch networker_bin_dir/pathownerignore

Run a second test probe to verify the configuration.

This command allows any path to be backed up for a client, whether it is owned by the 
virtual client or physical node. For detailed information, refer to the NetWorker 
Administration Guide.
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If pathownerignore was used, check that the scheduled save uses the correct client 
index. If the wrong index is used, force save sets to go to a specific index:

1. From the NetWorker Administration window, select a client and edit its properties.

2. For the Backup command attribute, enter the name of a backup script that contains 
save -c client_name. 

For detailed information about the Backup command attribute, refer to the NetWorker 
Administration Guide.

Uninstalling the NetWorker Software
To uninstall the NetWorker software from a cluster environment: 

1. If necessary, use the cluster management software to stop the NetWorker server 
services.

2. Shut down the client services on the node that the NetWorker software is being 
removed from:

nsr_shutdown

A list of NetWorker services appears and a prompt asks whether to continue with 
the nsr_shutdown command.

3. Run the following command:

/usr/bin/networker.cluster -r

4. Use SMIT to uninstall individual NetWorker software packages or all of the 
NetWorker packages at the same time.

5. To uninstall the NetWorker software, log in as root on the computer where the 
software is being removed.

6. Enter the following command to remove the NetWorker software:

smitty remove

7. Select F4=List to display a list of NetWorker software packages.

8. Select the NetWorker software packages to remove:

• Client software—select LGTOnw.clnt.rte

• Storage node software—select LGTOnw.node.rte

• Server software—select LGTOnw.serv.rte

• Man pages—select LGTOnw.man.rte 
• License Manager software—select LGTOnw.licm.rte

9. Press [Return] to uninstall the NetWorker software.
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Chapter 6: Evaluating and Licensing NetWorker
Software

This chapter explains how to enable the NetWorker software and features for 
permanent use. The chapter also describes the EMC Legato NetWorker licensing 
model and provides a basic explanation of licensing for the different NetWorker 
Editions, modules, and features, but it does not provide a comprehensive description 
of every possible licensing scenario. For specific licensing questions, contact a EMC 
sales representative.

When the NetWorker software is installed, it is in a temporary evaluation mode with 
all of the features available.

The chapter includes the following sections:

• "How NetWorker Software Is Licensed" on page 58
• "The Evaluation Process" on page 59
• "The Licensing Process" on page 60
• "Multiplatform Licensing" on page 64
• "Managing Legato Licenses" on page 66

How NetWorker Software Is Licensed
Licensing NetWorker software means entering enabler and authorization codes on the 
server for the NetWorker environment. Without these codes, the software or added 
features will not run beyond the evaluation period.

Each installation of NetWorker server software must be licensed with a base enabler 
that “turns on” the software and allows you to use a particular bundle of features, such 
as a specified number of clients and devices. All licensing takes place on the server: The 
licenses are entered and stored on the server, and the server enforces the licensing.

The NetWorker software editions enable varying degrees of functionality. Add-on 
enablers allow a broader scope of features. 
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The Evaluation Process
Evaluating NetWorker software can take place in two ways:

• Evaluating a new installation of the software on a NetWorker server
• Evaluating NetWorker features on an existing NetWorker installation

Evaluating a New Installation

When you first install the NetWorker software, you can evaluate it with all the features 
for 30 days free without entering any codes. 

By the end of the evaluation period, you must purchase, enter, and authorize a base 
enabler to continue using the NetWorker software to back up data. The base enabler is 
the license that enables the Edition purchased. To obtain a base enabler, contact either 
EMC Sales or a EMC Reseller. For more information about entering and authorizing 
the enabler, see "The Licensing Process" on page 60.

To continue using some of the features that were available with the evaluation 
software, you may need to purchase add-on enablers, depending on the Edition of base 
enabler you purchase. 

Evaluating Features on an Existing Installation

If you are evaluating one or more NetWorker features on an Edition of NetWorker 
software that has already been installed and enabled, you must enter a temporary 
enabler for each feature. The temporary enabler is valid for 45 days. 

• To obtain a temporary enabler code, refer to the Contents documentation in the 
Legato media kit, or contact EMC Sales or a EMC Reseller. 

• To enter the temporary enabler code, see " How to Enter a Temporary Enabler 
Code" on page 59.

By the end of the evaluation period, you must purchase, enter, and authorize the 
corresponding license enablers to continue using features you have evaluated. For 
instructions, see "The Licensing Process" on page 60. For more information about the 
different NetWorker Editions and features, see "Multiplatform Licensing" on page 64.

How to Enter a Temporary Enabler Code

Important: The temporary enabler code is valid on only one computer in a network. If 
you enter the same code on more than one computer in a network, a copy protection 
violation error occurs and the NetWorker server software is disabled on all NetWorker 
servers with duplicate enablers.
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To enter the temporary enabler code:

1. Start the NetWorker Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon. The NetWorker server appears in the 
right pane and left pane.

4. From the left pane, select the NetWorker server.

5. From the right pane, select the NetWorker application.

6. From the Enterprise menu, select Launch Application. The Administration 
window launches.

7. From the Administration window, click Configuration.

8. In the left pane, select Registration.

9. From the File menu, select New.

10. In the Enabler Code attribute, enter the enabler code.

11. (Optional) In the Comment attribute, enter a description of the license.

12. Click OK.

The Licensing Process
To permanently use NetWorker software, you must purchase and enter a license 
enabler code, and then authorize it. This licensing process is the same for all Editions 
of NetWorker software, as well as for individual features. To purchase the license 
enabler, contact a EMC sales representative. 

The license enabler code that you purchase is valid for 45 days, as a registration period. 
During the registration period, you must obtain and enter a corresponding 
authorization code. 

The following sections explain how to enter and authorize the license enabler:

• "Task 1: Enter the License Enabler Code" on page 60
• "Task 2: Obtain an Authorization Code" on page 61
• "Task 3: Enter the Authorization Code" on page 62

Task 1: Enter the License Enabler Code

License enabler codes are included in either the letter announcing the updated or 
upgraded software, or on the Enabler Certificate you receive when you purchase a 
software license. This depends on whether the software purchased is a first-time 
purchase, or an updated or upgraded version.

Note: To save time when entering a number of licenses, enter the base enabler last. 
Otherwise, once a base enabler is entered, devices that do not yet have licenses entered 
may be disabled; those devices would have to be re-enabled manually after their 
licenses were installed. 
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How to Enter a License Enabler Code

To enter an enabler code:

1. Start the NetWorker Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon. The NetWorker server appears in the 
right pane and left pane.

4. From the left pane, select the NetWorker server.

5. From the right pane, select the NetWorker application.

6. From the Enterprise menu, select Launch Application. The Administration 
window launches.

7. From the Administration window, click Configuration.

8. In the left pane, select Registration.

9. From the File menu, select New. The Create Registration dialog box appears.

10. In the Enabler Code attribute, enter the enabler code.

11. (Optional) In the Comment attribute, enter a description of the license.

12. Click OK.

The new license is added and appears in the right pane. Repeat the procedure to add 
any additional enabler codes.

Task 2: Obtain an Authorization Code 

Registration of NetWorker software takes place by obtaining an authorization code. 
Obtain a unique authorization code through one of the following methods:

• "Using the Website" on page 62
• "By Email" on page 62

Important: If the software or feature is not authorized by the end of the 45-day 
registration period, the NetWorker backup function or feature is disabled. However, 
data that was backed up during the registration period can still be recovered from local 
devices.
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Using the Website

Register EMC Legato products and obtain authorization codes online by completing a 
registration form at www.Legato.com. Web registration takes just a few minutes and is 
available 24 hours a day, 7 days a week.

An authorization code that permanently enables the NetWorker license will be sent by 
email.

By Email

To register the software and obtain an authorization code by email:

1. Start the NetWorker Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon. The NetWorker server appears in the 
right pane and left pane.

4. From the left pane, select the NetWorker server.

5. From the right pane, select the NetWorker application.

6. From the Enterprise menu, select Launch Application. The Administration 
window launches.

7. From the Administration window, click Configuration.

8. In the left pane, select the NetWorker server.

9. From the File menu, select Properties. The Properties dialog box appears.

10. Select the Customer Information tab and complete your contact information.

11. Email your registration information to EMC Legato Licensing.

An authorization code that permanently enables the updated NetWorker software will 
be sent to you. 

Task 3: Enter the Authorization Code

To complete the licensing process, you must enter the unique authorization code on the 
NetWorker server within 45 days of entering the license enabler code.

If the authorization process is successful, the expiration date for the license displays 
“Authorized - No expiration date.” If the authorization is not verified in this way, 
contact EMC Support. 
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Important: To avoid an interruption in scheduled backups if you move the NetWorker 
software from one computer to another, or to change the network address of a 
computer after the software is installed, do one of the following:
• Contact EMC Licensing to obtain a new authorization code. EMC requires the 

host ID of the original server, as well as the new server. The host ID appears in the 
server’s Registrations properties window.
For contact information, see "Support Sales, Renewals, and Licensing" on page 9. 

• Install and configure the Legato License Manager software. For more information 
about using the License Manager, see "Managing Legato Licenses" on page 66; 
also refer to the Legato License Manager Installation and Administrator’s Guide.

How to Enter an Authorization Code

To enter an authorization code:

1. Start the NetWorker Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon. The NetWorker server appears in the 
right pane and left pane.

4. From the left pane, select the NetWorker server.

5. From the right pane, select the NetWorker application.

6. From the Enterprise menu, select Launch Application. The Administration 
window launches.

7. From the Administration window, click Configuration.

8. In the left pane, click Registration.

9. In the right pane, right-click the license to be authorized, then select Properties.

The Properties dialog box appears.

10. In the Auth Code attribute, enter the authorization code for the product (the 
authorization code assigned to the specified permanent enabler or update enabler 
code).

11. Click OK.

The license is now permanently enabled.
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Multiplatform Licensing
The client connections that come with a NetWorker server can be used for only that 
server platform; a ClientPak license allows the NetWorker server to back up clients of 
different platforms. For example, the client connections accompanying a NetWorker 
server for Windows can be used only for Windows client computers; similarly, the 
client connections that come with a NetWorker server for Solaris can be used for Solaris 
clients only. With a ClientPak for UNIX, other UNIX platforms can be enabled for use 
with the NetWorker Server for Solaris. The ClientPak for UNIX supports all UNIX 
platforms; therefore, the UNIX ClientPak is sufficient for all UNIX clients backed up by 
a UNIX or Windows server.

Note: The NetWorker software treats Linux as a separate operating system, so a 
ClientPak for Linux is necessary to back up Linux clients by either UNIX or Windows 
servers.

Example: Multiplatform Licensing Schemes

A company was using an AIX server to back up Solaris, Linux, and Windows NT 
clients. It needed two ClientPak licenses, one for Solaris and one for Windows. The 
company added HP-UX and AIX clients, which required the addition of a ClientPak 
license for UNIX. 

As the company grew and needed to add a server, it added a Windows 2000 server, 
which backed up the Windows NT and subsequent Windows 2000 clients without 
requiring a ClientPak. The company also made the AIX computer a NetWorker server 
to back up the HP-UX, Solaris, and AIX clients, using a single ClientPak for UNIX. 

Update Enablers

To update existing NetWorker software to a major release, an update enabler is 
necessary. Update enablers are required for any major NetWorker software upgrade 
from release 4.0 and later, including the current NetWorker release. To use the Legato 
License Manager, the NetWorker server must be release 5.0 or later.

With a first-time purchase of NetWorker software, a one-year update agreement may 
be included. After a year, an update enabler may be acquired with a new update 
agreement purchase.
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Required Update Enablers 

Table 5 on page 65 lists the NetWorker releases that require update enablers.

Additional Licenses

This section describes a few of the additional licenses required to operate some of the 
NetWorker features. For a complete list, contact a EMC sales representative.

Client Connection Licenses

Every computer to be backed up in a NetWorker data zone requires a client connection 
license, even the NetWorker server. The client connection license may be one of the 
licenses supplied with the base enabler or purchased separately. A cluster client or 
NDMP data server requires a special type of client connection license, as described in 
"Cluster Clients" on page 66 or "NDMP Licensing" on page 66. 

Storage Nodes

Each storage node requires a storage node license in addition to its client connection 
license. A dedicated storage node, which allows the storage node to back up only itself, 
is licensed separately.

Table 5. NetWorker Update Enables

Upgrade 
from to 5.0 to 5.5 to 5.5.x to 5.6 to 5.7 to 6.x to 7.0 to 7.1 to 7.2 to 7.3

Any release 
prior to 5.0 

yes yes yes yes yes yes yes yes yes yes

5.0 yes yes yes yes yes yes yes yes yes

5.5 yes yes 
(UNIX 
only)

yes 
(NT 
only)

yes yes yes yes yes

5.5.x yes 
(UNIX 
only)

yes 
(NT 
only)

yes yes yes yes yes

5.6 NA* yes yes yes yes yes

5.7 yes yes yes yes yes

6.0 no yes yes yes yes

7.0 yes yes yes

7.1 yes yes

7.2 yes

* Release 5.6 is UNIX only, and release 5.7 is Microsoft Windows only. NT refers to Windows NT.
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EMC Legato NetWorker Application Modules 

NetWorker Application Modules are licensed on the basis of one enabler per database 
type host. For example, to back up the Oracle database on two hosts, two NetWorker 
Module for Oracle enablers are required, even if the two hosts are backed up by the 
same server. However, if multiple database instances are running on a NetWorker 
client host, only one NetWorker Module enabler is required for that one host.

Cluster Clients

For each physical node in a cluster, you must purchase a Cluster Client Connection, 
which takes the place of one standard client connection. For more information about 
licensing computers in a cluster, refer to the NetWorker Administrator’s Guide. 

NDMP Licensing

NDMP licensing requires one NDMP Client Connection per NDMP data server. The 
NDMP Client Connection is valid for any supported NDMP data server. The NDMP 
data server does not require a standard client connection. 

Managing Legato Licenses
The Legato License Manager provides centralized license management, allowing you 
to maintain all of an enterprise’s NetWorker licenses from a single computer. With the 
License Manager, you can move NetWorker software from one computer to another, 
or change the IP address on an existing NetWorker server without having to 
reauthorize the software. The License Manager can be installed as an option during 
NetWorker software installation.

The general steps to begin implementing the License Manager are:

1. Contact EMC Licensing to obtain bulk enabler codes. For contact information, see 
"Support Sales, Renewals, and Licensing" on page 9.

2. Install the License Manager software.

3. Configure the License Manager.

4. Configure the NetWorker servers to access the License Manager for their licenses.

For details about installing and using the License Manager, refer to the Legato License 
Manager Installation and Administrator’s Guide, 2nd Edition.
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